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Introducing EndNote 
 

 EndNote is a reference database--it specialises in storing, managing, and 
searching for bibliographic references in your private reference library.  

 
 EndNote is a bibliography maker--it builds lists of cited works 

automatically. Use EndNote to insert citations into word processing 
documents to compile a bibliography in any format that you need.  

 
 EndNote is an online search import tool--it provides a simple way to 

capture references from online bibliographic databases, library catalogues etc 

and import them directly into EndNote.  
 

The University of Nottingham has a site licence for EndNote which allows staff and 
students of the University free use of the software under the terms of the licence. 
The software can be used on PCs in the libraries, Computing Centre and other IS 

Computer Rooms.  
 

Please ask your School IT contact if you would like to have the software installed on 
a computer in your department.  
 

For off-campus use a personal licence is required and this is available from the 
suppliers, Adept Scientific.  The cost at the time of writing is £55 plus VAT and 

delivery. You should tell them, when ordering, that you are a student at the 
University of Nottingham which has a CHEST site licence for the software. EndNote 
is available for Windows or Macs. 

 
Adept Scientific plc, 

Amor Way 
Letchworth  
Herts, SG6 1ZA. UK 

 
http://edustore.adeptscience.co.uk/  (select University of Nottingham from the list 

of institutions and login with your University of Nottingham username and password 
to see the academic rates) 
 

Tel: 01462 480055 
Fax: 01462 480213 

e-mail: info@adeptscience.co.uk 
 
Another alternative for home use is to use Endnoteweb 

(http://www.myendnoteweb.com) which is fully functional, but does not have the 
same capacity for customisation as Endnote desktop.  However, both systems can 

be used and references can be transferred from one system to the other 
 

To see more information about the differences between the desktop and web 
version, see: 
http://thomsonreuters.com/products_services/science/science_products/a-

z/endnote_web 
 

http://edustore.adeptscience.co.uk/
http://www.myendnoteweb.com/
http://thomsonreuters.com/products_services/science/science_products/a-z/endnote_web
http://thomsonreuters.com/products_services/science/science_products/a-z/endnote_web
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More information about Endnote and a free demonstration version can be obtained 

from the EndNote site at:- http://www.endnote.com/ 

 

Versions 

The latest version is X4 (i.e. 14) but the University currently supports version X3 

 

Section 1: Opening EndNote and Creating a Library  
 

Start EndNote and Create a Library 

Note: In EndNote, databases of references are called “libraries”. 
 
Click on the Start button, then click on All programs, followed by EndNote and then 

EndNote Program. 
 

If you wish to use EndnoteWeb as well as EndNote, you can create an account at 
this point.  Click on the next button and register. 
 

If you already have an EndNoteWeb account, type in your email address and the 
password that you specified when registering and click on Finish. 

 
If you don’t want to work with EndnoteWeb, simply cancel. 

 
The first time you open Endnote, you will be asked for 3 choices 
 

 
 

Double-click the icon to create a new library.  You will be asked to save the library 
to a suitable location, for example to your Z drive or to a memory stick.   

 
The next time you open Endnote, the library that you have created will 
automatically open. 

 

Tip: Setting a default 
library 

You can choose whether you 
wish EndNote to open with a 
specific library or to allow 

you to choose a library by 
setting a default.   

 
From the Edit menu, click on 
Preferences and choose your 

favoured option beside When 
EndNote starts… 
 

http://www.endnote.com/
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Understanding the Toolbar 
The icons along the top of the toolbar allow you to perform basic functions.  You 

can however also access these functions from the drop-down menus at the top of 
the screen. 

 
 

 
 

 
 

 

 

 

Section 2: Adding References 
 

Start adding references to your new library.  There are two ways of adding 

references:- 
 Typing in references manually 

 Importing references automatically from an online database 
 

Create a New Reference Manually  

 

Open a library and choose New Reference from the References menu or click on the 

 symbol. An empty Reference window opens with the words "New Reference" 
displayed at the top.  

 
New references always appear as journal articles but can be changed to any other 

type of reference using the Reference Type drop down menu at the top of the New 
Reference window.  
 

 
 
Enter the information in the relevant fields: author, title date etc.  Move between 

fields by pressing Tab.  Except for authors which are entered Surname, initials 

Tip: Creating one Endnote library 

It is recommended that you only create one library in Endnote.  You can use 
groups to organise references together (see section 4) 

Select a 
referencing style 

Add a new 
reference 

Online 
search 

Import 
references 

Export 
references 

Find full 
text 

Open link 

Open file 

Insert citation 

Format 
bibliography 

Return to 
wordprocesser 

Help 

Quick 
search 
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(separated by full-stops, e.g., Smith, J. E.) no extra punctuation is entered into the 

reference; EndNote adds the necessary punctuation and text style changes to the 
references when it creates a bibliography.  

 
 

 
 
 

 
 

When you close the reference window, you will be prompted to save the 
information and the reference is then automatically saved as a new reference in 
your library.  

 
 

 

 

 

 

Section 3: Importing references from databases  
 
You can use Endnote to save references from bibliographic databases or from 

library catalogues by importing them electronically into your EndNote library. There 
are two methods, as explained below, a direct import facility is available for some 

databases but other require you to save a file of references which are then 
imported using an appropriate filter. 
 

For references to be imported with any of the EndNote filters, the data must be 
consistently "tagged," with each tag starting on a new line, and the file saved as a 

text file, as in these examples:- 

AU- CRAMER, -Z.O. 
TI- AQUATIC MACROPHYTES AND LAKE ACIDIFICATION 
PY- 1993 

SO- ENVIRONMENTAL-POLLUTION. VOL. 5, NO. 2, PG.54-79 

Author: Cramer, ZO 
Title: Aquatic macrophytes and lake acidification 

Year: 1993 
Source: Environmental Air Pollution. Vol. 5, (2) pp.54-79 

 
The tags enable the software to recognise which part of the 
reference is which and save them into the various fields 

correctly. 
 

The following exercises describe saving references from databases in two ways, one 
using direct download and the other using saved text files and import filters. 
 

NB. We do not recommend using the online search option to search bibliographic 
databases from within Endnote.  This is because you would lose the functionality of 

the database searching system and your search is likely to be less effective. 

Tip: Entering author names 
If you have more than one author, make sure that each author is entered on 

a separate line. 
If you have a corporate author or body, enter a comma after the name to 

ensure that it displays correctly, e.g. Department of Health, 

Tip: Transferring 
references from Word  
Because tags are 

needed for Endnote to 
read the reference, you 

cannot transfer 
references directly from 
Word to Endnote.  Try 

finding the references 
again using a database 

and importing them 

directly 

Tip: Knowing when a reference was added 

To see when a reference was added or updated, open the reference by double 
clicking on it and see the footer 
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3a. Direct Export 

Importing references from Web of Science  
 
The Web of Science is a multidisciplinary database covering journals and 
conferences relevant to the sciences, arts and social sciences. 

 
This method uses a simple direct import button to copy references from the Web of 

Science database straight into EndNote. 
Access the Web of Science from the eLibrary Gateway 
(http://www.nottingham.ac.uk/elibrarygateway) or launch from the library tab in 

the portal. 
 

Click on the titles tab and type in web of science.  Click on the link for the web of 
science. 
 

Conduct a search and mark some relevant references by ticking the boxes and then 
clicking on Add to Marked List. 

 
Now click on the Marked List button at the top of 

the screen to view the selected references. 
 
Select any extra details e.g. abstract, keywords as 

required and then click on the Save to Endnote 
button (NB not Save to my to EndNote Web). 
 

 

If your export does not begin automatically, click on the export button. 

Tip: Further help 
For more information on 

searching databases, see 
Pathway at 

http://webct.nottingham.ac.uk 

http://www.nottingham.ac.uk/elibrarygateway
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The references will automatically download into the Endnote library that you 

currently have open.  If you don’t already have Endnote open, you will be asked to 
select the library within EndNote into which you wish to import your references.  

When the import is complete, only newly imported references are showing in the 
Library window.  They are put into a group called Imported References where they 

can be checked. The original references plus the new ones can be viewed under All 
References 

Remember to return to Web of Science to log out when you have finished. 

 

 

 

3.b Non-direct export 

Importing from Cambridge Scientific Abstracts Collection 

This collection of databases covers a range of subject areas. 

This method involves two steps: 1) saving references as a text file and 2) importing 
the file into Endnote using a filter. 

 
Access the databases from the eLibrary Gateway 

(http://www.nottingham.ac.uk/elibrarygateway) or launch from the library tab in 
the portal. 
 

Click on the titles tab and type in CSA to view all databases within Cambridge 
Scientific Abstracts.  Choose a database that most suits your subject interests. 

Perform a search and mark some relevant references. 

Step1: Saving references as a text file 

From the display screen click on the Save/Print/Email button which appears above 

the first reference in the list of references displayed. The window below will appear. 

 
 

Tip: Diacritics 

Diacritics will often not import correctly from databases.  Go to 
http://www.nottingham.ac.uk/is/uon/knowledgebase/endnote.php#28 
to see how you can edit a reference using diacritics. 
 

http://www.nottingham.ac.uk/elibrarygateway
http://www.nottingham.ac.uk/is/uon/knowledgebase/endnote.php#28
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Click on the Save button towards the bottom of the screen, selecting whether you 

are using a PC or a Mac as appropriate. Give your file a name and save it as type 
Text File (*.txt) or type in the file suffix “.txt” after the file name to create a text 

file.  
Save it into a directory and note where this is so that you can recover the file again 

to import it into EndNote as follows. 
 

Step 2: Importing the Saved References into EndNote 
 

1. In EndNote open the library into which you want to import the references. 

2. Choose Import... from the File menu or click on the  icon and the following 
window will appear:- 
 

3. Click Choose File... to locate and open the file of references you want to import. 
(All files, except for EndNote libraries, must be plain ANSI or ASCII text files.) 
Select the file and click Open. 

 
 

 
 

4. Endnote only shows two CSA filters by default, so no matter which CSA database 

you have used, select the import filter e-psyche (CSA) from the Import Option list.  
If you can’t initially see this filter, click on other filters and select e-psyche (CSA). 
 

Please note that this filter does not work 100% and some manual editing may be 
necessary.  For example, journal articles are usually imported correctly, but other 

material types such as books or reports may not import correctly.  You may find 
that Endnote thinks these are journal articles and you will need to change the 

reference type accordingly. 
 
You may find that the specific filter for the CSA database may work more 

effectively.  If you wish to use the specific filter you will need to download it from 
the Endnote filters website.  For more information on downloading filters, see 

section 3c. 
 
5. Now select an option from the Duplicates drop down list. (A reference is 

considered a duplicate if the Author, Year, Title, and Reference Type match a 
reference already in the library.) The options are:- 
 

 Import All 
 Discard Duplicates 
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 Import into Duplicates Library 

 
 6. Click Import to import the file. 
 

When the import is complete, only newly imported references are showing in the 
Library window.  They are put into a group called Imported References where they 

can be checked. The original references plus the new ones can be viewed under All 
References. 

 

3c: Importing from some other commonly-used 
databases 

Databases we have at Nottingham and from which you can import include those 
listed below. The table below shows the format in which you need to save your 

references and the name of the import filter required. For details on how to 
import from other databases please ask your subject librarian. 

 

Downloading further filters 
Endnote only lists a few default filters. If any of the filters for the below are not 

recognised, you may need to download the filter from the web.   
 
In Endnote, click on Edit > Import Filters > Open filter manager and click on the 

button Get more on the web.  You can resort the list of filters by database name 
or information provider.  Click on Download to download the necessary filter.   

 
Saving filters 
If you are using a networked PC in a computer room, you should save the filter 

file to My Documents.  You must first of all create a folder within My Documents 
called Endnote and within that folder, create a sub-folder entitled filters.  Note 

that this will only be saved for the duration of your logged on session. 
 
If you are using a locally installed Endnote on your own PC, you should 

download the file into the filters folder where the Endnote program has been 
locally installed.  Typically, this is on the C drive in the programs folder > 

Endnote > filters. 
 
If you are unsure, you can check where Endnote will be searching for the filter, 

by going to Edit > Preferences > Folder locations. 

Remember that databases can be provided by different supplier.  Make sure you 
download the correct supplier’s filter.  If in doubt ask your subject librarian. 

Supplier      Database  Instructions  Filter                    
Cambridge 

Scientific 

Abstracts 

(CSA) 

Various indexes 

including: CSA 

Illumina, British 

Humanities Index, 

ASSIA, Metadex 

and many more 

 

 Click on 

save/print/email 

 Save File 

Format:PC or Mac 

as appropriate  

 Save as (*.txt) 

 Click on File and 

import 

 Choose .txt file 

 Choose import 

option e-psyche 

(CSA) or download 

the specific filter 

CAS  SciFinder  Click on Export 

 Save references as 

 Click on File and 

import 
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tagged format 

(*.txt) 

 Choose .txt file 

 Choose SciFinder 

(CAS)  

 

Ei Ei Compendex 

(Engineering 

Village) 

 Click on Download 

 Select “RIS, 

EndNote, ProCite, 

Reference 

Manager” 

 Click on Open 

Correct import filter is 

selected automatically 

 

Some manual editing 

is necessary, e.g. the 

part/issue number is 

sometimes not picked 

up 

Elsevier Science Direct  Click on export 

citations 
 Content format: 

choose level of 

information that 

you require 
 Export format: 

Choose RIS 

(Reference 

manager, ProCite, 

Endnote) 

 Select your library 

Correct import filter is 

selected automatically 

 

Elsevier Scopus  Click on export 
 Choose RIS format  
 Choose the level of 

information that 

you wish to be 

imported  
 Click on export 
 Click on open 
 Select your library 

Correct import filter is 

selected automatically 

Google 

 

Google scholar 

 

 You will need to 

configure Google 

Scholar to send 

references to 

Endnote.  See: 

http://www.endnot

e.com/support/Faq

s/Import/faq11.asp 
 Use the Import 

into Endnote link 
 Choose open file 

Correct import filter is 

selected automatically 

 

Some manual editing 

may be required 

IEEE IEEE/IET  Click on download 

citations 

 Choose the level of 

information you 

wish to download 

 Choose format: 

Endnote, Procite, 

Refman 

 Click on download 

citation 
 Choose your library 

Correct import filter is 

selected automatically 

 

NLM PubMed There are 2 options: 

 

 

 

http://www.endnote.com/support/Faqs/Import/faq11.asp
http://www.endnote.com/support/Faqs/Import/faq11.asp
http://www.endnote.com/support/Faqs/Import/faq11.asp
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Online search 
 Click on PubMed in 

the online search 

group in Endnote 
 Choose how many 

references you 

wish to import 
 Click on OK 

 

Saving as a text file 
 Click on drop-down 

menu beside 

display settings 

and choose 

Medline. Click on 

apply 
 Go to File and Save 

as and save as a 

text file 

 Import the text file 

into Endnote using 

the Pubmed Import 

 

 

 

 

 

 

 

 

 

 

 Click on File and 

import 

 Choose .txt file 

 Choose Pubmed 

(NLM) filter 

OvidSP  Various databases 

including: 

 AMED  

 CAB Abstracts 

 Embase 

 Food science & 

technology 

abstracts 

 Inspec 

 International 

Pharmaceutical 

Abstracts 

 Medline 

 PsycInfo 

 Click on Export 

 Choose export to 

Endnote 

 Click on export 

citations 

 Choose your 

Endnote library 

Correct import filter is 

selected automatically 

 

Some manual editing 

may be required. E.g. 

when downloading 

from CAB Abstracts, 

the year is not 

included 

 

Thomson (TS) Web of Science  Click on save to 

endnote button 

Correct import filter is 

selected automatically 

 

Importing from the Nottingham eLibrary Gateway 

 

References retrieved through meta searching on the eLibrary Gateway can easily be 
imported with a simple procedure. 

Select the databases that you wish to search 
Enter your search terms  
1. Add items to your basket and view them by selecting My Space and then eShelf. 

2. Select records by marking the boxes and then click Selected to get a window 
containing the chosen references.  Here click on  

3. Save and select Record Format Citation manager and click save.   
4. References will be automatically imported, but may need some editing.  
This method can be used to import references from the Library Catalogue, UNLOC. 
 



 12 

You have now created a library by inputting references automatically from 

databases and by manual typing.  The next set of exercises look at 
handling references in a library. 
 

 

Section 5: Managing references 
 

Displaying references 
 
When you open a Library you see the Library window listing all of the references 
that the library contains: 
 

 
For each reference, the Library window displays the first author's last name, the 

year, and as much of the title as will fit in the window. (The default display can be 
altered in the Display Fields menu under Edit – Preferences and Display Fields). If 
you highlight a particular reference more detail is shown in the lower half of the 

window in the chosen style. You can browse through your reference library by using 
the scroll bar, the scroll arrows, or the Page Down, Page Up, Home, End, and Arrow 

keys.  
 

Select & Open a Reference  
 

To work with specific references you must first select them in the Library window by 
double clicking on a selected reference in the list. Chose one of the references you 
have retrieved from a database. 
 

The Reference window opens to display all of the information associated with the 
reference. This is where you enter or edit information for a reference. The citation 

information displayed at the top of the Reference window (e.g. Argus, 1991 #11) is 
used by EndNote to match citations in a paper to references in a library. 
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To view the rest of the reference, use the mouse to scroll down through the 

Reference window. Note that you can hide empty fields with the button at the top 
right of the window. 

 
EndNote will prompt you to save any changes made to a reference when the 
Reference window is closed. 

 
 

Linking to the Full-text 
 

Endnote provides several ways of linking to the full-text of an article. 
 

Automatic linking 
If you use a database such as Web of Science or PubMed, an html link to the 
database record will automatically be populated into the URL field.  If the University 

subscribes to the full-text of the article, you can click on the link and browse to the 
full-text.   

Alternatively, highlight a reference in your library and click on references from the 
top menu and the URL option, followed by openURL.  Please note that not all 
journals in these databases will be subscribed to by the University. 

 
Typing in the URL 

You could simply type in the web address for the full text of an article in the URL 
field of the reference.  For journals it is recommended that you use the DOI (Digital 
Object Identifier) code to create the URL adding http://dx.doi.org/ before the DOI 

number.  E.g. htto://dx.doi.org/10.1016/S0040-4039(97)82966-8  
 

DOI numbers are often shown on the website or PDF of journal articles.  
 
Attaching files manually 

To attach a PDF file, right click the reference in the list view, select file attachments 
and attach file.  Then browse for the document. 

 
Automatically finding the full-text 
If the University subscribes to the full-text article, you can ask Endnote to find it 

and automatically attach it to your reference. To do this you must enter details of 
the OpenURL resolver used by the University in the preferences area.  Click on Edit 

> Preferences > Find Full Text. 

http://dx.doi.org/
http://dx.doi.org/10.1016/S0040-4039(97)82966-8
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In the OpenURL path enter: http://sfx.nottingham.ac.uk:80/sfx_local 

Click on OK. 
 

Highlight the reference(s), then click on the references option in the top menu and 
choose find full text.  You will then need to accept the copyright statement.  

Endnote will then search for the full-text (this can take several minutes) and if 
found, a paperclip icon will display next to the reference.   
 

To view the PDF, double-click on the reference and scroll down to the file 
attachments field.  Double-click on the file icon to open.  Or, right-click on the 

paperclip icon and scroll down to the file attachments option and click on open file. 
 
 

 
 

 

 
 
 
 
 
 
 
 
 
 
Creating Groups 
 
My groups 
Groups can be created to collect together references on a particular topic. Click on 

the groups option on the menu bar and select create group.  Enter a name for your 
group.  You can then simply drag and drop references from your main library into 

any of your groups.  The references will show in your group, but also remain in the 
main library.   

 
If you have a lot of groups you can also create group sets to organise your groups 
in a more manageable way.  Click on the groups option and create group set.  Then 

drag and drop any of your individual groups into the group set. 
 

 

Watch out: Not 100% fullproof 
This method uses a variety of ways to locate the full-text from our 

subscriptions but it is by no means full-proof.  There are many reasons why the 
full-text may not be found even when we do have a subscription, for example, 
many publishers will automatically block bulk downloading of PDFs.  In these 

cases, you could attach the file manually. 
 

To check whether we do subscribe to the full-text, click on the references 
option from the top menu bar and click on the URL option and then OpenURL 
Link.  This will take you to the SFX window and clarify whether the full-text is 

available or not. 
 

http://sfx.nottingham.ac.uk/sfx_local
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Smart groups 
Smart groups allow you to set up a search strategy and any references that match 

that search strategy will automatically be moved to the relevant smart group.  To 
set up a smart group, go to Groups and Create smart group and enter your search 

strategy and click on Create. 
 
To edit the search terms for the smart group, right-click on the group name in the 

groups panel and select Edit group. 
 

Note that smart groups are a temporary location for references.  There is no facility 
to manually move references from all references or from a custom group into a 
smart group.  It is advisable to move references from a smart group into a custom 

group if you wish to be able to manually move references as well as dynamically 
populate the group.  A smart group can have the same name as a custom group. 

 
 

Search for a Set of References  

 

Choose Search Library from the Tools menu to open up a search box in the bottom 
pane.  
 

Type in a search word in the first search item and select the field in which you wish 
to search.  

  
To find references from e.g. 2001 or later, type in the date in the search window,  
choose Year from the drop down field list in the second search item.  Then change 

“Contains” to “is greater than or equal to” from the drop down comparison list in 
the Search window. Search terms can be linked with AND and OR.  

 
The search below is for references containing the word “extinction” published since 
1990: 
 

 
 

Extra lines to combine more than three searches can be added by using the + 
button. 
 

You can also choose to search by added to library or last updated and enter a date. 
 

You can either search the whole library or references that are showing.  For 
example, you could select a group and then choose Search showing references 
from the drop-down menu. 
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If you wanted to convert your search to a smart group, click on Options, followed 

by Convert to Smart Group. 
 

To return to the preview view, click on the preview tab in the bottom pane. 
 

To carry out a quick search, use the quick search box at the top of the page and 
type in your search term 
 

 

Sort References 

The Sort References command is used to sort the references in the library window. 

By default, the library window is sorted alphabetically by first author.  You can sort 
by displayed fields by clicking on the column headings. To sort references by other 
fields: 

Choose Sort Library from the Tools menu. 

 

 

Use the drop-down menus to choose the field(s) to be used for sorting. 

Click on the button to the right of the field to specify ascending or descending 
order. 

Click on OK. 

 

 

 

 

 

 

 

 

 

 

 

Tip: Print References  

In order to simply print out a list of references, you first select references by 
highlighting them with the mouse, using the Ctrl key to highlight several. Then 

select a reference style e.g. Author-Date or Numbered from the drop-down Style 
list at the top of the screen. Note that a sample of the reference style is shown in 
the lower display window.  If you wish the abstract to also be printed, click the 

Annotated style. 
Choose Print from the File menu. A standard print dialog will appear. 

Click OK to begin printing. 
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Section 6: Select Other Bibliographic Styles 
 

Bibliographic styles are files that are used to control the appearance of references 
in a bibliography.  A set of standard styles is already installed in the Endnote 
software. Styles can be modified and new styles can be created using EndNote's 

style editor. 
 

To view the styles available click on Edit, Output Styles and then Open Style 
Manager in Endnote. 
 

After a short delay a list of journals for which output styles are available is 
displayed: 

 

 
 

Click on the column headings to sort by Name or Category. 
 
Click in the boxes to the left of the names to select styles for a list of “Favourites”. 

These will appear in the Output Styles list under Edit in Endnote. 
 

By clicking on the “More Info” button you will be able to see the full details of a 
style.  Clicking on the style info/preview will show you exactly how the reference 
will be displayed for this style. 

 
If you wish to view more than the default styles, click on the Get more on the 

web button.  Find the style you want and click on download.  Save the file.  If 
you are using a locally installed Endnote on your own PC, you should download 
the file into the styles folder found within the Endnote folder where the program 

has been locally installed.  Typically, this is on the C drive in the programs 
folder.  If you wish to save an output style to use on a networked PC, you 

should save the file to My Documents.  Note that this will only remain for the 
duration of your logged on session. 
 
 

Modifying output styles 
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EndNote has a wide range of output styles to suit different referencing styles and 
journal requirements, but occasionally you may not find a style to suit your 

particular needs so it is possible to edit a style. 
 

Click on Edit from the top menu and then output styles.  Select the style that most 
fits your requirements (e.g. author-date) and click on edit (e.g. edit author-date) 
 

 
 
You can then modify how the intext citation will look and how the reference will 

look in your bibliography. 
 
For example, if you have a reference with 3 or more authors, you may with to list 3 

authors before the word et. al. rather than the default 2 authors.  Click on author 
lists within the citations option and change the author list options appropriately. 

 

 

 
Another example could be changing the title of the journal from underlined to bold 

within your bibliography reference.  Within the bibliography section, click on 
templates and select the word journal and use the formatting buttons at the top to 

change to bold. 
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You can then save a copy of the style. 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 

 

Section 7: Using EndNote with a Word Processor 
 

This section demonstrates the facility which inserts EndNote commands to Word's 
and WordPerfect's Tools menu to give you direct access to your references while 
writing in your word processor. This enables EndNote to do all of the bibliographic 

formatting work to the document that is currently open.   
 

Working with Word 2007 
 
Insert an EndNote Citation into the Paper 
Open word and open an existing paper or begin typing a new paper. 

 
You should see that a tab for EndNote has appeared.  If you cannot see the 

EndNote tab, close down Word and reopen.  Note that you always need to have 
your Endnote library open when working with Word 
 

Tip: Saving changes to styles 
If you are using a locally installed Endnote on your own PC, you should download 

the file into the styles folder found within the Endnote folder where the program 
has been locally installed.  Typically, this is on the C drive in the programs folder. 
If you are using a networked PC in a computer room and want to be sure to be 

able to see your modified style again, save to your Z (network) drive.  However, 
you must then make sure that Endnote looks to your Z drive for this style. Go to 

the Edit menu in Endnote, click on preferences and then folder locations.  The 
location should be: Z:\EndNote\Styles 
 

If you have been using a previous version of EndNote, you may find that the 
location is not correct and you will need to change it. 
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Click on the Endnote tab and click on the option to Insert citation and then click on 

Find Citation 

 

 
 
This will take you to EndNote where you can search for the reference you require. 
Highlight the appropriate reference then click on Insert. This will add the reference 

into the text in Word and begin creating the bibliography.   
 

Repeat the process until all references have been inserted. 
 
Alternatively, you can click on the Go to EndNote option, highlight your chosen 

reference from your library and click on the insert citation  button 

 
Then save your document 
  

To format again with a different bibliographic style:  

To format your reference list according to the reference style of your choice, click 
on the drop-down menu in the second column beside the word style.  

 

 
You will see some default styles such as Author-Date and Numbered and any other 

styles that you have previously selected or saved as favourites 
 

Select a style and you will see that your intext citation 
and bibliography will be reformatted according to that 
referencing style.  To see a full list of output styles, click 

on Select another style from the drop-down menu and 
click on the style of your choice to reformat. 

 

Tip: Switching 

between Endnote 
and Endnoteweb 

To switch between 
working with Endnote 

and Endnoteweb, click 
on preferences in the 
third column of the 

Endnote tab.  Choose 
the applications tab. 

Select EndNoteWeb 
from the drop down 
menu and login with 

your email address 
and Endnoteweb 

password. 
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To browse styles by subject category rather than 

alphabetically, click on the category heading. 
 

 
 

 
 
 
 
 
Working with 
Word 2003 
 
Insert an EndNote 

Citation into the 
Paper 
Open Word and open an 
existing paper or begin 

typing a new paper. 
 

Open the EndNote X2 
toolbar from the View – Toolbar menus. 
 

 
 

 

 

  
 

 
To add in a reference, select Go to Endnote from the toolbar. 
 

This will take you to EndNote where you can search for the reference you require 

Highlight the appropriate reference and click on the  icon to insert the citation. 

This will add the reference into the text in Word and begin creating the 
bibliography.   
 

Repeat the process until all references have been inserted. 
 

Alternatively, you can search for your references by clicking on the Find citation(s) 
option from the toolbar.  Search for the appropriate reference and click on insert. 

Then choose Save from your word processor's File menu.  
 
(When working with EndNote in Word you can click on Tools, EndNote to see a drop 

version of the toolbar if you prefer) 

Insert 
note 

Remove 
field codes 

Generate figure list 

Tip: Editing a citation 

To exclude the author from your citation, click on Edit 
citation in the top left.  Select the author you wish to 

remove and click in the exclude author checkbox. 
E.g. Smith (Smith, 2003) argues that… can be turned 
into Smith (2003) argues that… 

 
Follow a similar procedure to exclude the year from 

your citation.  E.g. In 2003 (Smith, 2003), it was 
argued that… can be turned into: In 2003 (Smith), it 
was argued that… 

 
To include page numbers in your citation, click on: Edit 

citation in the top left and enter the page number(s) in 
the suffix box, adding p. or pp. before the number if 
you wish this to display. 

 
To remove a citation completely, click on Edit citation, 

highlight the citation and click on remove. 

Insert  selected 
citation(s) 

Find 
citation(s) 

Unformat citations Export travelling library 

Cite whilst you write preferences 

Help 

Go to 
Endnote 

Format 
bibliography 

Edit citation(s) 
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To format again with a different 

bibliographic style:  

 

Choose Format Bibliography from your word 
processor's EndNote toolbar.  
 

 
 

A style confirmation dialog appears, prompting 
you to choose a bibliographic style for the paper.  
 

A Format Bibliography dialog box appears 
allowing you to select a particular style. 

 
Change the “with output style” selection to begin 
formatting the paper and bibliography in a new 

format. 
 

To view more styles click on the browse button. 
 

 
 

Switching between Endnote and Endnoteweb 
 
In Word 2007, to switch between working with Endnote and Endnoteweb, click on 

preferences in the third column of the Endnote tab.  Choose the application tab. 
Click in the radio button to select EndNote Web and login with your email address 
and Endnoteweb password.  

 
In Word 2003, go to the Endnote toolbar from the tools menu, click cite while you 

write preferences.  Choose the applications tab.  Select EndNoteWeb from the 
application drop-down menu and login with your email address and Endnoteweb 
password.  

 

Section 8: Exporting references between Endnote 

and EndNoteweb  

Tip: Editing a citation 
To exclude the author from 

your citation, click on Edit 
citation in the top left.  Select 
the author you wish to remove 

and click on remove. 
E.g. Smith (Smith, 2003) 

argues that… can be turned 
into Smith (2003) argues 
that… 

 
To include page numbers in 

your citation, click on: Edit 
citation in the top left and 

enter the page number(s) in 
the suffix box, adding p. or pp. 
before the number if you wish 

this to display    
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To transfer references from your Endnote library to an Endnoteweb library, click on 
Endnoteweb from the tools menu within the desktop version of Endnote 
 

Choose the appropriate Endnoteweb library/group from the drop-down menu. 
Click in the radio button for Transfer references from desktop to web 

Choose to: 
 Transfer references that are showing 
 Transfer all references in the library 

 Transfer references in the group (select your group from the drop-down 
menu) 

 
Click on transfer 

 
 
 

Section 9: Exit from EndNote 
 

Exit from EndNote by choosing Exit from the File menu 
 

 

 

 

Further Information 
 

For frequently asked questions, see: 

http://www.nottingham.ac.uk/is/uon/knowledgebase/endnote.php 
 

http://www.endnote.com/support/ensupport.asp 
 

Online tutorials available at: 
http://webct.nottingham.ac.uk 

 Click on the option for Pathway 
 Click on the button for Advanced modules and module 10: Managing references 

 

For information on how to reference particular types of material, see: 

http://webct.nottingham.ac.uk 
 Click on the option for Pathway 

 Click on the button for Introductory modules and module 12: Citing and 
Referencing 

http://www.nottingham.ac.uk/is/uon/knowledgebase/endnote.php
http://www.endnote.com/support/ensupport.asp
http://webct.nottingham.ac.uk/
http://webct.nottingham.ac.uk/

